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1.1 What is EndNote?

EndNote is reference management software that can be used to:
e Store and manage the citations you find while doing your research; and then

e Add these citations into a Word document (either as in-text citations or as footnotes), which
automatically creates a styled bibliography at the end.

1.2 Downloading EndNote

e UTS staff and students can download a free copy of EndNote from:
https://www.lib.uts.edu.au/referencing/endnote

¢ Instructions on how to install correctly are available on UTS ServiceConnect: hitps://uts.service-
now.com/serviceconnect/?id=kb_article&sys id=70e4e6846fcc4e00089be4021c3ee426&table=k

b_knowledge
¢ If you are unsure which version is best for your computer, check the EndNote compatibility page:

https://endnote.com/product-details/compatibility/#windowshttps://endnote.com/product-
details/compatibility/

o For further instructions from downloading through to advanced EndNote use, visit the Library’s
EndNote video playlists:

o EndNote 20:
https://www.youtube.com/playlist?list=PLffOP30ayhYWPiINOJ4992Wm2Xpqyf-sin

o EndNote for Researchers:
https://www.youtube.com/playlist?list=PLffOP30ayhYUPSax 6H1tC8A7Ez6DtTE

1.3 Downloading the AGLC Style

For EndNote to display your references in your preferred style, it needs to know what that style is.
To download the AGLC style for EndNote, you need to complete these steps:

o Step 1: install the legal reference types (we need the reference types file because EndNote does
not come with many of the legal reference types that are required by the AGLC style).

e Step 2: install the AGLC style
o Step 3: select AGLC4 as your output style

Go to https://www.lib.uts.edu.au/referencing/endnote#3 and follow the instructions carefully and
complete all these 3 steps.

1.4 Create an EndNote Library

¢ Open EndNote and click on File, New. Give your library a name and Save it. EndNote libraries
save to your Documents folder by default, so if you use several computers you might prefer to
save to a USB or portable drive.

£% Library 1
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e It's best to use just one library. You can structure your library into different topics later, using
Groups.

o Select AGLC4 (UTS) style by using the Style dropdown menu at the bottom right of the
library. If the style isn’t already in the dropdown, use Select another Style to choose it. It
may have a slightly different name because the style gets updated from time to time.

16/04/2021 Journal Arti philosophers who weaken the no-self ace
Select Another Style... Oﬂh?]f
16/04/2021 Journal Arti seltir
| v Aclca uTS) | d the
16/04/2021 Journal Arti Annotated hat it
APA 6th nimal
. arma
16/04/2021 Journal Arti APA Tih Equir
16/04/2021 Journal Arti Author-Date
Chicago 17th Footnote
16/04/2021 Journal Arti MHRA (Author-Date)
. Numbered
16/04/2021 Journal Arti i
Show All Fields
16/04/2021 Statute (Uni = Turabian 9th Footnote
A Vancouver on
>

If you still can’t find it, you may not have downloaded it properly: see Section 1.3 above.
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2.1 Inserting references manually into the EndNote Library

e Open your EndNote Library

¢ Click on the ‘Add a new reference to the selected group’ icon

AR@

—l Add a new reference to the selected group (Ctrl+MN)

¢ Note different reference types for the AGLC4 style (if you don’t see a lot of legal reference types,
you haven’t installed the AGLC reference types properly. See section 1.3 above):

v Bill
Bill or Resolution (US)
Bills Digest or Alert Digest
Blog Post
Book
Book Chapter
Case (Arbitral)
Case (Medium MNeutral)
Case (Reported)
Case (Reported, without short title)
Case (United States Reported)
Case (Unreported no Medium Meutral)
Case Submission
Case Transcript
Conference Paper
Court Orders
Dictionary
Edited Book
Electronic Article
Film
Gazette
Generic
Internatl Arbitral, Tribunal Decisions
Internatl Courts of Justice
Internatl Criminal Tribunals, Courts
Internatl Unreported
Internet Material with Author
Internet Material without Author
Interview
Journal Article
Legal Encyclopedia
Looseleaf Service
Magazine Article

Memarandum of Understanding
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¢ Once you've chosen your reference type, fill in the appropriate fields. Some guidance about
which fields to use can be found in Part 3: Templates for manually entering legal references into
EndNote. You don’t need to fill in every field.

() See Part 3: Templates for manually entering legal references into EndNote for

guidelines on which fields to complete.

o What you type in needs to be very accurate. Pay good attention to spelling, capitalisation, and
punctuation.

e Put your own notes in the Research Notes field.

¢ Once you have entered all required data for that reference, close the new reference window and
check the citation under the Preview pane on the right. Is it displaying correctly?

2.3: General tips for inserting data into EndNote fields

¢ Personal author names: Enter authors as Surname, First names. Each author should be on a
separate line. Enter all authors — the style will know how to deal with multiple authors.

o Corporate authors: Enter the full name followed by a comma, eg Department of Justice,

e Years: enter these without brackets. You may see fields labelled for round or square brackets
which you should use as appropriate. EndNote will then add the correct type of brackets.

e Journal, book and article titles: should be entered in full, with all major words capitalised.

o Judges and their titles should be listed on one line exactly as you want them to appear, eg
Gleeson CJ, Gummow and Hayne JJ.

¢ Punctuation: in most cases you don’t need to add brackets, commas, italics etc as EndNote will
do this for you. Exceptions apply when inserting paragraph numbers or some pinpoints (see
below).

e Numerals: ordinal numbers (eg 256™ or 2"9) should have the ordinal part (“th” and “nd” in these
examples) superscripted as shown. There is an icon to do this in the top left of the reference
template in Windows. In a Mac, select Edit > Font > Superscript).

2.3 Editing references after importing

Carefully check, and if necessary edit, each reference as soon as it is in your Library. Use the
Reference and the Preview panels for this.

e To edit a reference (including to change reference type), use the edit option in the Edit panel on
the right of your library.

e You can leave as many fields blank as you wish, you only need to type in what will appear in the
footnote and the bibliography.

( ) See Part3: Templates for manually entering legal references into EndNote for

guidelines on which fields to complete.

e ltis possible to add custom fields into a reference to suit your needs. For example, you may
want to add a custom field for methodology or extra notes to keep you organised. If you need
help with this, please contact your faculty librarian.

£% Library 1
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3.0 Footnotes
When you install EndNote, this creates an extra tab in Microsoft Word, labelled EndNote 20.
e Open a blank Microsoft Word document.

e Click on the EndNote tab. This is the EndNote plugin that allows EndNote and Microsoft Word to
talk to each other.

o Make sure the style AGLC4 (UTS) is selected in Word.

Home Insert Design Layout References Mailings Review View Zotero EndNaote 20 Grammarly Acrobat

59 EN Go to EndNote Style: AGLC4 (UTS) - Eﬁh Categorize References ~ Export to EndMote ~ o
et F}"Edit&Manage Citation(s) |5+ Update Citations and Bibliography Instant Formatting is Off = l]ﬂl:‘l,l\f'lanuscript Matcher Help
Citation ~ E'.;;(.Edit Library Reference(s) B Convert Citatians and Bibliography - _.—-.__'-Preferences
Citations Eibliography P Tools

3.1 Adding References into Footnotes
e Go to your EndNote library,

o Select the references that you wish to add to a particular footnote. You can select more than one
reference by holding down the Control key (Windows) or Command key (Mac).

¢ Return to your Word document and place the cursor in your text, after the word where you want
the footnote number to appear.

¢ In Word, click on the References tab, then Insert Footnote (Windows); or click on Insert >
Footnote (Mac).

File Home Insert Design Layout Mailings
E 18 Add Text - ABI [y Insert Endnote B =1 Manag
BI Update Table AE! [ext Footnote ER Style: |
Table of . Insert 5 Insert _E t}‘ .
Contents = Footnote Citation - £ Bibliog
Table of Contents Footnotes P Citations & Biblio)

Insert Footnote (Alt+Ctrl+F)

Add a note at the bottomn of the
page providing more info about
something in your document.

16

This will place the footnote number in your text, and create a footnote with that number at the
bottom of the page.

¢ In Word, click on the EndNote tab. Ensure that AGLC style is selected. Place your cursor in the
footnote at the bottom of the page and choose Insert Citation > Insert Selected Citation(s).

£% Library |
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Home Insert Design Layout References Mailings Review View Zotero EndMote 20

95 EN Go to EndMote Style: IAGLC:l (UTS) vI &Categorize References - Export to EndMote
o F‘}‘Edit&ManageCitatinn(s} E,'-UpdatelCi‘ca'ciu:msar'u:lEil:uliogra[:nl*'ﬁ,.r InstantFormattingi:On' ﬂﬂﬂManuscriptMatcl’
Gl E‘-}j— Edit Library Reference(s) E‘-, Convert Citations and Bibliography ~ E Preferences
Eﬂ Insert Citation... B Bibliography ] Tools
IIE%‘,\ Insert Selected Citation(s) I FR—— X T -
E] Insert Note..

. Insert Selected Citation(s)
!5 Insert Figure...

Insert a citation for each selected
e reference in the frontmost EndMote
. library.

The citations will appear in the footnote, formatted correctly. You can type some text in front of, or
after any footnotes, if you wish.

! Mabo v Queensland (No 2) [1992] 175 CLR 1 ('The Mabo case'}.l

¢ Inserting citations into footnotes also starts creating your reference list at the end of the
document. Do not worry at this stage about categorising your reference list: this can be done later
and is covered in a later section of this guide.

Repeat this process for all your footnotes. Note that Word will maintain the correct numerical order of
footnotes, both in-text and at the bottom of the pages, no matter what order you insert them into your
document.

3.2 Short Titles

When you add a new reference to your EndNote library, if there is no author you will need to add a
short title into the reference's Short Title field. You don't need to do this if the reference has an author,
such as books, most reports, journal & newspaper articles and so on.

For Cases, the short title should be either:
e The popular case name if there is one; or
e The first word or couple of words of the name of the first party; or

o Ifthe first party is the Crown, the first word or couple of words of the name of the second party.

For short titles of Legislation or Treaties:
e Ifthere is a standard or popular short title, use this.

¢ If the name of the legislation is 1-3 words long, not including the year, use this name. Eg for the
Crimes Act 1900 (NSW) the short title entered into EndNote would be Crimes Act.

¢ If the name of the legislation or treaty is long, use a few distinguishing words or use the initials of
the words in the title (see examples in the AGLC).

£% Library 1
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o Make sure all your short titles are different. For example if you are citing the Crimes Act 1900
(NSW) and the Crimes Act 1958 (Vic) in your document, you will need to add extra information to
the short titles, which would be something like Crimes Act 1900 and Crimes Act 1958.

For other legal materials, you should consult the AGLC for guidance about the form of short titles

3.3 Pinpoints

Citations often need to refer to a specific page or section within a reference: this is called a pinpoint.
Pinpoints do not appear in your reference list, only in footnotes.

Pinpoints are added by EndNote to citations in footnotes in AGLC in the same way as for citations in
other styles:

o Select (click on) the citation in the footnote (you will see it has a grey shading)
e Choose Edit & Manage Citations in the EndNote tab

¢ The Edit Citation window opens. You'll see the selected citation highlighted in the top half of the
window. If the citation was part of a group of citations, make sure you choose the correct one
from the listed group in the top half of the window.

e If your pinpoint is a page number or a range of page numbers, just add the numbers to the
Pages box in the lower half of the window. For example: 6 or 6-7 or 6, 8, 10.

¢ If your pinpoint is a paragraph number or range of paragraph numbers, add the numbers
enclosed in square brackets to the Pages box. For example: [6] or [6]-[7] or [6], [8], [10].

¢ If your pinpoint is to a section, clause or article number etc, add the abbreviations for these into
the Pages box, followed by the numbers. For example: s 6 or ss 6-7 or cl 6, 8, 10 or art 31.1.

3.4 Repeated Citations in Different Footnotes

3.4.1 Repeated citations in consecutive footnotes

EndNote will automatically convert such repeated citations to Ibid, as required by AGLC rules. You can
add pinpoints to the Ibid if you wish, in the same way you add them to a normal citation.

If you add a footnote in between two footnotes, where the second one is an Ibid, and then add a different
citation to the middle footnote, the Ibid will revert to non-consecutive repeated citation format, as it
should (see next section for these).

3.4.2 Repeated citations in non-consecutive footnotes

It is quite common to cite a reference in several different, non-consecutive footnotes. AGLC handles this
in quite a complex way, and EndNote therefore has to be a bit complicated here too. The AGLC rule is:

¢ If the reference has authors, all repeated non-consecutive citations will use the surnames of
these authors plus (n #) where the # is the number of the footnote where the reference was first
cited in the document.

e If the reference does not have authors, all repeated non-consecutive citations will use the
reference's short title (see the Short Title section above), also followed by (n #) where # is the
number of the footnote where it was first cited.

=% Library 1
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EndNote knows about these rules, but it doesn't know what the required first footnote number is, so
when you insert a reference that has been cited earlier (but not in the directly preceding footnote) you
will get either one of:

e Surnames (n

e Short Title (n

In both cases, to add the number of the first citing footnote, leave the cursor in the footnote just after
the (n and click on References > Cross-reference (Windows) or Insert > Cross-reference (Mac).

Below is the image for Windows:

File Home Insert Design Layout WGEENCHECM Mailings Review View Zotero Acrobat EndNote20 () Tell me what you want to do...
- 1d Text 1 | t Endnot it 5 Manage Sources sert Table of es | ¥ Insert Ind
1 AB . D’[ﬂ k o = I
date lable AB Next Footnote ~ B Style: APA il = : p abl Update Inde :
Table of Insert Insert . Biblioatanhve Cite While ert E Mark Mark
Contents ~ Footnote = Show Notes citotion T gy You Write Caption —% Cross-reference Entry Citation
Table of Contents Footnotes [ Citations & Bibliography EndNote Captions Index Table of Autho
Cross-reference ? X
Reference type: Insert reference to:
~ | |Footnote number ¥
Insert as hyperlink D Include above/below
Separate numbers with
For which footnote:
1 RvTang (2008) 237 CLR 1 {Tang).
2 Crimes Act 1900 (NSW) s 114.
3 Tang (n
* Rv Tang (2008) 237 CLR 1 ('Tang'). Cancel
2 Crimes Act 1900 (NSW) s 114.
% Tang (n

The Cross-reference window will open (see image above).
o Select Footnote from the Reference type drop down menu as shown

e Select from the list of footnotes in the document, the one where your reference was first cited. In
our example, the reference we are citing for the second time in footnote 3, Tang, was first cited
in footnote 1, so we select footnote 1

o Click Insert at the bottom of the window (you will then see the number appear after n in the
footnote)

e Select Close at the bottom of the window

¢ Finally, after the number in the footnote, type a close bracket, then any pinpoint you might want
to add, and then a full stop.

3.4.3 Updating cross-references

It is possible that you might add footnotes into your document in such a way as to disturb the order of
these cross-references. For example in our example, if you add a footnote before the first citation of
Tang, the original footnote number 1 becomes number 2, original 2 becomes 3, original 3 becomes 4
and so on. We now need to change the cross-reference in the repeated footnote from (n 1) to (n 2).
There may be many other cross-references to many other footnotes that will also need to be changed.

£% Library 1
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Luckily the cross-reference feature in Word allows this to be done easily. It can be done at any time, as
often as you like, and should certainly be done just before you submit a document for publication or
assessment.

¢ Click onto any footnote in your document, and press Control + A (Windows) or Command + A
(Mac). This will select all text in all the footnotes.

o Press the F9 key on your keyboard (Windows) or Command + click and select Update Field
(Mac).

e Click Yes to continue.

e All the cross-reference numbers in all the repeated citations will now be updated to the corrected
numbers for their first citing footnotes. In our example, (n 1) will be changed to (n 2).

3.5 Editing references in footnotes

Editing references in footnotes (eg fix a spelling mistake, add missing information): first make those
changes to the reference in your EndNote library. Then return to Word and click on the Update
Citations and Bibliography option in the EndNote toolbar.

File Home Insert Design Layout References Mailings Review View Zotero EndMote 20

L1 EN Go to EndMNote Styles | AGLC4 (UTS) - ﬁt Categorize References - Export to EndMote
E‘}‘ Edit & Manage Citation(s) |E' Update Citations and Bibliography I Instant Formatting is Off = l]m,l Manuscript Match

Insert —
Citation = E-}:‘(-Edit Library Reference(s) P2, Convert Citations and Bibliography - = Preferences

Citations Bibliography Fa Tools

3.6 Removing footnotes

To remove a footnote, select the reference click on Edit & Manage Citations

Home Insert Design Layout References Mailings Review View Lotero
L] EN Go to EndNote Style: AGLC4 (UTS) - EEE Categorize References - Export to EndMote
- |_’L_",‘ Edit & Manage Citation(s) |__=,I Update Citations and Eibliography Instant Formatting is Off = ﬂﬂ'ﬂManuscript Match
TEelism = E‘-ﬁ.Edit Library Reference(s) B2 Convert Citations and Bibliography ~ EPrEferences
Citations Bibliography Fa Tools

o Finditin the list of citations. Use the Edit Reference dropdown on the right of the highlighted
reference to select Remove Citation, then click OK.

£% Library |
7 June 2021 @ 14 |



EndMote 20 Edit & Manage Citations

Citation Count  Library

Mabao v Queensland (Mo 2) [1992] 175 CLR. 1 (The Mabo case’).

Edit Library Reference
Find Reference Updates...

R Citati
Edit Citation Reference Emove ion

Inzert Citation

Formatting: | Default N Update from My Library...

Prefix:

Suffix:

Pages:

Tools = Cancel Help

Totals: 1 Citation Group, 1 Citation, 1 Reference

Removing a citation from a footnote in this way does not remove it from the reference list if it was cited in
another footnote.

<

-
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4.0 Bibliography

4.1 Dividing your Bibliography into Categories

In legal referencing we need to separate our bibliography into categories of references. To do this, in
your EndNote tab in Word, select Categorize References > Configure Categories.

Layout References Mailings Review View Zaotero EndMote 20 Grammarly
Style: | AGLCA (UTS) ® @-Cat&goriz& References = Expu:urttu:u EndMote ~ 0
LE,! Update Citations and Bibliography Group References by Custom Categories atcher e

EIE
E Convert Citations and Eibliography = Configure Categories...
Bibliography M e 2
S >2  + 1., ConfigureCategories
]

The following window appears:

EndNote 20 Configure Categories X
+ | Category Headings |Search References v | Find
References Author Year  Title Reference Type Category
All References in Bibliograp... (3) 1900 Crimes Act Statute C Legislation
Uncategorized References (0) 2008 RvTang Case (Reported) B Cases
Category Headings Stephanie 2017  Female Chief Justice Rewrites the ... Newspaper Article A Artides/ Books/ Reports

—| Primary Sources (0)
-| Secondary Sources (0)
=| A Articles/ Books/ Reports (1)
-| B Cases (1)
=| C Legislation (1)

Use the Category Headings plus sign icon to add your category headings. These might be:

o A Articles/ Books/ Reports,
o B Cases,

o C Legislation,

o D Treaties

o E Other

... and so on, as in the example above. You only need to add the categories you need.

e The list on the right shows all the references in the bibliography. Drag and drop each reference
from this list onto its appropriate category

¢ You can drag and drop references from one category to another, but each reference can only be
in one category

o Categories will appear in the bibliography in the order displayed here. You can rearrange the
categories, by dragging them up or down here, to change their order in the bibliography

e Within each category, references will be arranged according to the normal rules of your style (in
AGLC this will be alphabetical order)

e Categories with no references allotted to them will not appear in the bibliography

¢ References in the document that have not been allocated to a category appear in a temporary
category called Uncategorized References. Once you allocate these to a category, this
temporary category disappears.
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4.2 Editing your Bibliography

o Correcting spelling mistakes or changing information in references, should be done as before by
making the changes in your EndNote library and then selecting Update References and
Bibliography in Word.

o Some reference types (eg some United States Statutes) may not be able to be categorised and
will stay in the Uncategorized References category in your reference list.

¢ Also, some references may not be in the proper alphabetical order within their category in your
reference list. There may also be some issues with commas in some pinpoints. These problems
are more difficult to correct. You should ignore them until you have inserted all your
references and pinpoints into your document’s footnotes.

e Once you are sure that you have inserted all references and all pinpoints, if there are any
references in the reference list that cannot be categorised, or that are out of alphabetical order
within their category:

o save your document. and then
o click on Convert Citations and Bibliography > Convert to Plain Text in Word.

Design Layout References Mailings Review View Zotero EndMote 20

Style: AGLC4 (UTS) - ﬁe Categorize References - Export to EndMo
ian(s) LE,' Update Citations and Bibliography Instant Formatting is Off = l]m‘[ Manuscript Matd
efs) m Convert Citations and Bibliography - I E Preferences

[% Convert to Unformatted Citations P! Tools
Convert to Plain Text —
"'Elx = I ey
Convert Reference Manager Citations to EndMo o
% Convert to Plain Text
m! Convert Word Citations to EndMote
Canom v mmmne af semnire dacinmm mmd swondlm

This creates a copy of your document without any EndNote field codes, and which can be edited
like a normal Word document. Just cut and paste the troublesome references into the correct
alphabetical order in their correct category. At this point you can also edit errors in pinpoints as
well, if there are any.

¢ If you then decide that you still need to insert another reference or pinpoint, you will need to
return to your original saved document with the EndNote field codes, add in the new references
and pinpoints, and repeat the steps above to create a new Plain Text version.

=% Library 1
e 2021 @ 17 |



Part 3 — Templates for manually entering legal references into EndNote



Legal Reference Type

in EndNote

EndNote Fields

Examples and Additional Notes

Neutral)

(AGLC4: 2.3.1)

Unique Court Identifier
Judgment Number
Short Title

Bill Year Evidence Bill 1994 (Cth).
Title of Bill
Jurisdiction See also Explanatory Memoranda below

(AGLC4: 3.2) Short Title

Book Author Malcolm N Shaw, International Law (Cambridge University Press, 7t ed,
Year 2014).
Title

(AGLCA4: 6) Publisher ¢ Note superscript in edition number. You need to set this in the
Volume reference in your EndNote library
Ed't'or ¢ Use Translator, Original Title and Original Year of Publication fields only

ransiator for translated works

Original Title
Original Year of Publication

Book Chapter Author Jeremy Waldron, 'Do Judges Reason Morally?' in Grant Huscroft (ed),
Year _ Expounding the Constitution: Essays in Constitutional Theory (Cambridge
Chapter Title University Press, 2" ed, 2008) 123.

(AGLCA4: 6.6) Editor o .
Book Title e Note superscript in edition number. You need to set this in the
Publisher reference in your EndNote library
Volume The same fields are available for translated works as for books
Starting Page
Edition

Case (Medium Year Quarmby v Keating [2009] TASSC 80.
Case Name

Avoid using this format for reported cases
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Case (Reported)

(AGLC4: 2)
(AGLC4: 2.2)

Year - Round Brackets
Case Name

Law Report Abbreviation
Reporter Volume
Starting Page

Short Title

OR

Case Name

Law Report Abbreviation
Reporter Volume (if there is one)
Starting Page

Year - Square Brackets

Koop v Bebb (1951) 84 CLR 629.
OR
Bakker v Stewart [1980] VR 17.

e There are two alternatives for enclosing the Year, depending on
whether the reporter is organised by:

o Volume Number: the year appears in ()

Year: the year appears in [ ]. These cases will often have no volume number

Short Title
Case (Unreported gasi Name Barton v Chibber (Supreme Court of Victoria, Hampel J, 29 June 1989).
; ou
no Medium Neutral) Judge e Use this format for unreported US cases as well.

(AGLC4: 2.3.2)

Judgment, Docket or Reference Number
Full Date

If the unreported case is in medium neutral format, use Case (Medium
Neutral) format above

Short Title
Conference Paper '_?_‘_‘ilthor (use this format for unpublished conference papers)
itle
Name of Conference lan Mutton, 'Extra-Territoriality: A Case Study' (Conference Paper,
(AGLC4: 7.2.4) Type of Paper International Trade Law Conference, 29 May 1997)

Full Date of Conference

If the Conference paper has been published in a conference proceedings,
use the Book Chapter format above




Electronic Article

(AGLC4: 5.10)

Author

Year

Title

Journal

Part

Volume

Issue Number

Pages

Article Number/ldentifier
Issue if a month or season

Kate Lewins, 'What's the Trade Practices Act Got to Do with I1t? Section 74
and Towage Contracts in Australia' (2006) 13(1) eLaw Journal: Murdoch
University Electronic Journal of Law 58.

e Ifthe issue is a month or season use that field instead of Issue

Use Article Number/ldentifier field only if needed

Internet Materials
with Author

(AGLC4: 7.15)

Document Title
Web Page Title
Full Date
Document Type
URL

Explanatory ytle of Bill Explanatory Memorandum, Equal Opportunity Bill 1995 (Vic).
ear
II\E,I:[;T:I::’:‘::( (l)\l:)tes Jurisdiction e Use the Bill reference type in EndNote
Short Title Type the extra words such as Explanatory Memorandum into the Title field
in EndNote
(AGLC4: 3.7)
Author Martin Clark, 'Koani v The Queen', Opinions on High (Blog Post, 18 October

2017) <http://blogs.unimelb.edu.au/2017/10/18/koani-case-page/>.



http://blogs.unimelb.edu.au/2017/10/18/koani-case-page/

Internet Materials

Document Title
Web Page Title

'General Information', International Whaling Commission (Web Page)

without Author Full Dat <https://iwc.int/iwcmain>.
ull Date
Document Type '‘Gender, Equity and Human Rights', World Health Organization (Web Page,
(Or if the author is the | URL 2019) <https://www.who.int/gender-equity-rights/en/>.
same as the Web Page '‘James Edelman', High Court of Australia (Web Page)
title) <http://hcourt.gov.au/justices/current/justice-james-edelman>.
¢ Note there are two different reference types depending on whether
(AGLC4: 7.15) or not there is an author
o If the author is the same as the Web Page Title, leave out the
author
Use last update date for full date if this is available; otherwise just use year
or month and year. Leave out altogether if no date is given on the website.
Interview Interviewee Interview with John Howard, Prime Minister of Australia (Clive Robertson,
Interviewer ABC Television, Sydney, 21 December 2001).

(AGLC4: 7.13)

Position of Interviewee

Forum or Form of Interview or Location

Full Date
Journal Article Author Stan Ross, 'Battered Wife Syndrome and the Role of Lawyers' (1998)

\T(%ar 72(11) Law Institute Journal 39.

itle
(AGLC4: 5) Journal OR
_ Part Ross Grantham and Charles Rickett, 'Property and Unjust Enrichment:

(AGLC4: 5.3) Vol

Iscs)l:Jerzne Categorical Truths or Unnecessary Complexity' [1997] (1) New Zealand Law

Starting Page
OR

Author
Title
Journal

Review 668.

e There are two alternatives for enclosing the Year depending on
whether the journal is organised by:

o Volume Number: the year appearsin ()

o Year: the year appears in [ ]



http://www.who.int/gender-equity-rights/en/
http://hcourt.gov.au/justices/current/justice-james-edelman

Part

Volume

Starting Page

Year - Square Brackets
Issue - Square Brackets

If the issue number is a month or season, use the Issue - Square Brackets
field instead of the Issue field even if the year is in round brackets

Legal Encyclopedia

(AGLC4: 7.7)

Publisher

Encyclopedia

Name of Title

Title Number

Volume Number

Name of Chapter
Chapter Number
Paragraph

Date of Retrieval OR
Full Date of Last Update

LexisNexis, Halsbury's Laws of Australia, vol 15 (at 25 May 2009) 235
Insurance, '2 General Principles' [235-270].

Westlaw AU, The Laws of Australia (online at 15 February 2018) 2
Administrative Law, '2.3 Access to Information’ [2.3.10]

Use only one of Date of Retrieval or Full Date of Last Update fields.

Looseleaf Service

(AGLC4: 7.8)

Author or Publisher

Title

Publisher if there is also an Author

Most Recent Service Type and Number OR
Volume

Date of Retrieval

Neil J Williams, LexisNexis Butterworths, Civil Procedure: Victoria, vol 1 (at
Service 299) [21.01.1].

CCH International, Australian Intellectual Property Commentary (online at
20 February 2018) [[7-000].

J W Carter, LexisNexis, Carter on Contract (online at 20 February 2018)
[04-001].

o Most Recent Service Type and Number field refers to the
Paragraph and is given at the bottom of the page in the printed
version. Add the word Service or Release into the EndNote field as
well as the number.

e If using the online version, use the Date of Retrieval field instead,
with the date you viewed the paragraph. Enter paragraph numbers
as pinpoints in footnotes including the square brackets.

In the second example, T is the paragraph symbol, see AGLC4 7.8




Newspaper Article

(AGLC4: 7.11.2)
(AGLC4: 7.11.4)

Author

Title

Newspaper

Place of Publication (print only)
Starting Page

Section

Full Issue Date (online) OR
Full Issue Date (print)

Brook Turner, 'Higher Education: The Cutting Wedge', The Australian
Financial Review (Sydney, 5 January 1998) 7.

Farah Tomazin, 'Kinder Wages Breakthrough', The Age (online, 19 May
2009) <http://www.theage.com.au/national/education/kinder-wages-
breakthrough-20090519-bewh.html>.

o Use Type of Article field only if needed, eg for a Letter to the Editor

(AGLC4: 24.4.1)

Column (UK Debates only)
Date of Debate

Type of Article etc.
Use only one of Full Issue Date (print) or Full Issue Date (online)
Parliamentary Jurisdiction Commonwealth, Parliamentary Debates, House of Representatives, 23 May
Debate ghafiber 1992, 3121 (Paul Keating, Prime Minister).
peaker
Speaker Position United Kingdom, Parliamentary Debates, House of Commons, 16 February
(AGLC4: 7.5) Volume (UK Debates only) 1998, vol 306, col 778 (Jack Straw).

e Use also for UK Debates: you will then need to use the Volume and
Column fields.

¢ If the Jurisdiction has more than one word, type a comma after the
last word

Only use the Speaker Position field if this is relevant to the speech

Parl. Paper or
Committee Report

(AGLC4: 7.1.2)

Author

Title

Document Type
Legislature

Paper or Report Number
Session (UK only)

Full or Partial Date

Environment and Natural Resources Committee, Parliament of Victoria,
Inquiry into the Environmental Effects Statement Process in Victoria,
Parliamentary Paper No 59, September 2011).

e Use Author for the Committee Name. Type a comma after the last
word

e Type Parliamentary Paper into the Document Type field if required

e Use also for UK Parliamentary Papers (AGLC4 24.4.3), but include
the

Legislature in the Document Type field, not the Legislature field. UK
Papers also use the Session field.



http://www.theage.com.au/national/education/kinder-wages-

Press or Media

Author
Title

McLibel Support Campaign, 'McLibel Crisis as Defendant and Office Fight

Release Eviction Threat' (Press Release, 17 May 2001).
Release Type
Document Number If the Author and the releasing body are the same, do not use Body field
(AGLC4: 7.3) Body
Full Date
Regulations & Year _ Police Regulations 2003 (Vic)
Delegated Title of Act or Regulation _
leqislati Jurisdiction e Use Statute reference type in EndNote
egisiation Short Title
(AGLC4: 3.4)
Reports and A_uthor Community Law Australia, Unaffordable and Out of Reach: The Problem of
Similar -Fl;ltlte)l' h Access to the Australian Legal System (Report No 2, December 2012).
Documents Y:arls er e Use Book as the reference type in EndNote

(AGLC4: 7.1.1)

¢ Add the document type to the Publisher field

e If there is a Document Number, add this to the Publisher field too,
after the Document Type, with the word No in between (see above
example)

e Add the Full or Partial Date to the Year field

Royal or Law
Reform
Commission Report

(AGLC4: 7.1.3)
(AGLC4: 7.1.4)

Title of Royal Commission

Law Reform Commission

Type of Law Reform Commission Report
Type of Publication

Volume

Number

Date

Short Title

Royal Commission into Trade Union Governance and Corruption (Final
Report, December 2015).

Australian Law Reform Commission, Elder Abuse (Discussion Paper No 83,
December 2016).

¢ For Royal Commission Reports, use Title of Royal Commission
field

o For Law Reform Commission Reports, use Law Reform Commission
and Title of Law Reform Commission Report fields




Audiovisual

Studio/Production Company/Producer
Version Details

Speech Speaker Justice Dyson Heydon, 'Threats to Judicial Independence: The Enemy
Title Within' (Speech, Inner Temple, 23 January 2012).
Institution/Forum/Location
(AGLC4: 7.3) Type of Speech
Full Date
Statute Year _ Sex Discrimination Act 1984 (Cth).
Title of Act or Regulation
Jurisdiction e Use this format for Regulations, Delegated Legislation, Constitutions
(AGLC4: 3) Short Note that this format is for Australian or NZ statutes; use other reference
Title types for Canadian, UK or US statutes.
Television, Radio & gpi_SOdfll_Ilit'e 'The Paradise Papers', Four Corners (Australian Broadcasting Corporation,
eries Title

2017) <http://www.abc.net.au/4corners/the-paradise-papers/9124930>.
'Inventions: Who Owns Them?', The Law Report (ABC Radio National, 8

Date Signed - Bilateral or Trilateral
Treaty Series Details

(AGLC4: 7.14.3) Date of September 2009)

) Broadca <http://www.abc.net.au/rn/lawreport/stories/2009/2678819.htm#transcrpt>.
(AGLC4: 7.14.4) st URL Use Studio/Production Company/Producer for the Broadcast Station
Thesis Author Jeremy Kirk, 'Implied Rights in Constitutional Adjudication by the High Court

Y_ear of Australia since 1983' (D Phil Thesis, Oxford University, 1998).
(AGLC4: 7.2.5) L‘tl_e _ In the Thesis Type field, just add the abbreviation for the degree, eg PhD

e niversi

ty

Thesis

Type
Treaty: Bilateral or Title _ Convention on the Avoidance of Double Taxation with Respect to Taxes on
Trilateral Signatories Income and Capital, signed 20 November 1978, Canada-Romania, 1467

UNTS 241 (entered into force 29 December 1980).

(AGLC4: 8) Date Signed and Entered into Force OR International Agreement on the Schelde, Belgium-France-Netherlands,
Date Entered into Force signed 3 December 2002, 2351 UNTS 13 (entered into force 1 December
Short 2005).
Title Agreement Relating to Co-operation on Anti-Trust Matters, Australia-United
States of America, 1369 UNTS 43 (signed and entered into force 29 June
1982).
D .
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http://www.abc.net.au/4corners/the-paradise-papers/9124930
http://www.abc.net.au/rn/lawreport/stories/2009/2678819.htm#transcrpt

¢ Note there are two alternative formats depending on whether it is a
bi-/tri- or multi-lateral Treaty

e Use this format for Conventions and other International Agreements
Treaty Series Details field should contain volume number or year of
volume, series abbreviation, and starting page number or sequential
number

¢ If necessary, use the Date Signed and Entered into Force field
instead of the separate Date Signed and Date Entered into Force
fields.

Treaty: Multilateral

Title
Date Opened for Signature - Multilateral

Treaty for the Non-Proliferation of Nuclear Weapons, opened for signature 1

. July 1968, 729 UNTS 161 (entered into force 5 March 1970).
(AGLC4: 8) Date Entered into Force Y ( )
Treaty
Series
Details
Short Title
United Nations /T*_}:IthOF Universal Declaration of Human Rights, GA Res 217A (1ll), UN GAOR, UN
Doc e Doc A/810 (10 December 1948).
ument Resolution Abbreviation and Number ( )
Official Records Abbreviation Maurice Kamto, Special Rapporteur, Third Report on the Expulsion of
(AGLC4:9) Committee Number Aliens, UN Doc A/CN.4/581 (19 April 2007).
Session Number UN SCOR, 62" sess, 5663 mtg, UN Doc S/PV.5663 (17 April 2007).
Part Number
Meeting Number General and Complete Disarmament, GA Res 49/75, UN Doc A/RES/49/75
Agenda ltem (9 January 1995, adopted 15 December 1994).
I N
Supplement Number o Use only those fields that are appropriate to the specific document.
UN Document Number M field has C ittee. Session. Part. and Meeti
Author's Official Position any fields such as Committee, Session, Part, and Meeting
Numbers will not be needed.
Full Date
Annex Number e For the Resolution Abbreviation and Number field, add both the
Short Title abbreviation for the type of resolution and the resolution number
Annex Title
o Forthe UN Document Number field, add only the document
Full Date of
Adoption (if number
necessary) Note superscripts for ordinal numbers. You need to set these in the reference
in your EndNote library.
(7 .
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Written
Correspondence (eg
Letters)

(AGLC4:7.12)

Type of Correspondence
Sender

Collection Title
Collection Location
Recipient

Full

Date

URL

Letter from Ellen Keen to George Rusden, 28 April 1867 in George William
Rusden: Collection of Personal and Historical Papers (Royal Historical
Society of Victoria, Melbourne).

Letter from Deloitte Touche Tohmatsu, Melbourne, to Opes Prime Clients, 1
April 2008
<http://deloitte.com.au/media/docs/OpesPrime_groupcircular.pdf>.

Use Collection Title and Collection Location fields if the correspondence is
contained in an archive

Use a URL if this would assist in recovery of the document



http://deloitte.com.au/media/docs/OpesPrime_groupcircular.pdf
http://deloitte.com.au/media/docs/OpesPrime_groupcircular.pdf

Contact Us

If you have questions about using EndNote, please contact the Library using the contact us form:
https://www.lib.uts.edu.au/get-help/contact-us

Enquiries, feedback and bookings

Select One
Memberships/Borrowing/Returns/Renewals/Fines
v/ Referencing/Referencing Software
Finding a Resource/Accessing an online resource
Assignment Help
Librarian consultations (HDR and UTS Staff only)
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